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System Requirements: 
 

To ensure the best performance using HotDocs, please note the following requirements for hardware and 
software:  
 

System Requirements of HotDocs Developer LE 11 
 
Please visit this link for the requirements:  https://www.hotdocs.com/products/hotdocs-developer-11-
system-requirements  
 
**NOTE: Microsoft Word is recommended. 

 

Technical Support: 
 
Technical Support is available to help you install and use IowaDocs® .  If you are having difficulties installing or 
using the software contact us at the following: 

 
Internet  www.iowadocs.net 
Email Support support@iowadocs.net 
Support Phone (866) 597-6040 

Subscriptions 
(Through HotDocs Market) 

844-536-4343 
www.hotdocsmarket.com 

 
Support is available from 9:00 A.M. to 3:00 P.M. central standard time, Monday through Friday, if a technician 
is not available, please leave a detailed message.  Please have your HotDocs Market primary account email and 
password available in case we need to access your HotDocs Market account. 

 

https://www.hotdocs.com/products/hotdocs-developer-11-system-requirements
https://www.hotdocs.com/products/hotdocs-developer-11-system-requirements
http://www.iowadocs.net/
mailto:support@iowadocs.net
http://www.hotdocsmarket.com/
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Introduction: 

IowaDocs® is a library of templates related to the practice of law in Iowa.  These legal forms are created, 
endorsed and copyrighted by The Iowa State Bar Association. Most IowaDocs® forms are available in two 
formats, PDF and word-processing (RTF) formats.  IowaDocs® does contain state forms that are not to be 
altered and are not offered in rtf formats.  These forms are clearly marked in the IowaDocs® library with “State 
of Iowa Form” labeled in the description of the forms. 

PDF forms (Form Templates, HPT) graphical-based electronic form file. A form template contains fixed-
space fields, represented by lines, boxes and check boxes where answers are placed.  The bordered 
forms operate in the Hotdocs program and cannot be edited. The purpose of the bordered form is to 
give the parties involved the assurance that the language of the document is standard, eliminating the 
need to proof read. Text cannot be deleted, but must be stricken through. Additional text can only be 
added where existing text does not exist. These forms can only be printed on laser printers.  

RTF’s (Document Templates) contain the text of the original document plus may include instructional 
scripts (information) for correctly assembling a customized document. After HotDocs assembles a 
document, it is placed in the word processor for saving, printing or additional editing.   These forms are 
identical to the bordered forms in content. The same questions are asked in both formats. RTF forms 
can be manipulated like any other word-processing file. These forms should be used if editing is 
needed or if using inkjet printers. 

With the purchase of IowaDocs® you actually have several programs. Each is displayed with a separate icon in 
the HotDocs icon group. (HotDocs, HotDocs Filler, and the IowaDocs® Library)  

HotDocs Developer LE is a software tool that significantly reduces the time spent generating customized 
documents such as contracts, court forms, and  legal documents.  Using HotDocs, you can transform any word 
processor file into an interactive template by replacing the changeable text with HotDocs variables. The next 
time you want to generate that document, just use the HotDocs interactive template you've created. The 
template prompts you for information and puts the finished document back in your word processor. By adding 
functionality and power to your word processor, HotDocs helps you generate customized documents 
accurately and efficiently.   

NOTE:  ISBA does not support training in creation of you own automated templates. 
 

HotDocs Filler a program that allows you to fill graphics-based HotDocs forms (PDF Forms).  It is used to open 
previously saved IowaDocs® PDF type documents. Once a template is opened and completed it is detached 
from the IowaDocs® program and saved as a HotDocs form with the file extension HPD (HotDocs PDF 
Document). HPD files are not recognized by IowaDocs® or any word processing program and must be opened 
through the HotDocs Filler program. 
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 Launching IowaDocs®: 
 
Display the Library 
 

▪ To display the IowaDocs® Library:   Choose HotDocs 11 at the Start/Programs menu. The IowaDocs® 
library window should appear.  If it doesn’t appear, then click on the File menu and select 
“PUBIOWADOCS” from the listing. 

▪ Below is a sample of the IowaDocs® library navigation screen: 
 
 
 

 
Figure 1 

 
 
 
Opening or Closing a Folder 
 

▪ Open folders are represented by this icon.   

▪ Closed folders are represented by this icon . When a folder is open, you can see the files and 
subfolders that are in it.  

▪ To open or close a folder, Double-click the folder icon. 
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Finding a Form 
 
You can use the “Find” feature in order to find a form in the library.  Most forms have a title with the form 
number, which can be used to find forms.  Some forms have specific descriptions (HIPAA and state forms) 
which the “Find” feature can use to look for a form. 
 

▪ To use the find feature, have the IowaDocs® Library window open (see Figure 1 on page 6). 
▪ At the bottom left locate the Find dialog box, type in your search text (i.e. 102 or deed) 
▪ A list will be produced with forms that have that criteria.  (i.e. looking for 102 will produce the RTF and 

PDF of form 102-Warranty Deed) 
▪ During this search, the checkbox will be checked.  To go back to the library window, uncheck this box. 

 
Printing a Form  
 

▪ To print an IowaDocs® PDF form, simply right-click on the form you would like to print and select the 
option “Print Template”.  This will result in the printing of only that form, not the whole listing of the 
library.  Caution: some forms have variables defaulted to add additional pages or activate other 
options on forms, printing a form directly may affect the final output of the form 

 

Printing a List of Forms  
 

▪ To print a listing of all the current forms go to http://www.iowadocs.net  and click on List of Forms. 

http://www.iowadocs.net/
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Assembling an IowaDocs® Form: 
 
To start HotDocs/ IowaDocs® 
Choose HotDocs 11 at the 
Start/Programs menu. The 
IowaDocs® library window appears.   
 
To start HotDocs, you can also click 

the HotDocs button ( )in any 
word processor toolbar. This will 
open and display the IowaDocs® 
library window. 
 

Assemble or Fill a Form 
You assemble a document by 
selecting a template and then 
providing the required variable 
information. 
 
To Assemble/Fill a document 
 

1. At the HotDocs library window, select a template. 
2. Click Assemble. The Answer File dialog box appears.  
3. Select the type of answer file needed, then click OK. 
4. If this is a new answer file then it is recommended that you save your answer file.  Go to File/Save 

Answers or click on the  Save Answers icon in the toolbar. (for more information on answer files 
please visit the answer file section of this manual).  Once named you can use the keyboard shortcut of 
Ctrl + S to manually save your current answer file. 

5. Answer the dialog questions in the “Interview Tab”, then click Next to advance to each new dialog. 
 
After the final dialog, the End of Interview dialog identifies how many questions haven't been answered. This 
dialog also provides options for working with the assembled document.  Please see “End of Interview Options” 
section for a discussion on options available to you. 
 
NOTE:  Image on next page outlines the “assembley screen”. 
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Navigation of IowaDocs® Assembly Screen 
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Filling a Form Directly 
 
To fill a form directly (not recommended, cannot directly fill a word-processing (RTF) type form) 

1. At the HotDocs library window, select a form template and begin assembling the document.  
2. If it's not selected automatically, click the Document tab. The assembly window changes to show the 

document, and the variable fields. 
3. Select a field, then type an answer.  Note: some fields need to be overwritten as they are combination 

fields (need more than one answer from the interview) in order for a direct fill. 
 
Press Tab to move to the next field, or use the mouse to select another field. 
 

*Tip 

Some fields have a field wizard—a series of one or more dialogs to help you answer the field when you are filling the form directly. If a 
field has a wizard, a wizard button will appear next to the field when its fill control is displayed. Click the button to see the wizard. 
 
If the template author has provided help for a field, a help button may appear next to the field when its fill control is displayed. (The 
help button will only appear if the author has enabled it in the template and if the Show Help Buttons check box is selected in 
Preferences. For details, click here.) If there is help for the field, you can display it even if the button doesn't appear by clicking the 
What's This button in the toolbar and clicking the field. 

 
Assembling and Filling Multiple Documents and Forms 
 
You can assemble and fill multiple forms at once by selecting multiple templates. One document or form will 
be produced from each selected template. The Assembly Options dialog box will appear only once, and all the 
templates and clause libraries will use the same answer file. 
 
To assemble and fill multiple documents and forms 

1. Display the HotDocs library window. 
2. Select each template you want to use. (To select multiple items, hold down the Ctrl key as you click 

each one.) 
3. Click Assemble.  
4. If you want to use an existing answer file, specify it at the Current Answer File box. (For details, click 

here.) 
5. Click OK. 

 
NOTE:  If you would like to assemble documents in a certain order then you should do the following steps- 
 

1. Start assembling the first template. 

2. Click on the  to go back to the IowaDocs®  library. 
3. Double-click on the other forms you would like to assemble in the order you would like to assemble 

them.  Remembering each time to click on the  . (you should now see the Assembly Queue window.  
This shows what forms are “assembling” and forms that are “confirmed”.) 

4. To go back to the first form – double click on the form in the Assembly Queue.  When you close/finish 
with this form the next form will start automatically, with the answer file you used for the other 
document. 

 

*Tip 

If you have selected only document templates, you will be asked about saving answers when the last document is done assembling. If 
you have one or more form templates selected, you won't be asked about saving answers until the last form is saved or closed. 
However, when you save a form, it is no longer connected to the answer file, even though other forms may be. 
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Finished Documents or Forms 
 
PDF based Forms 
Until saved or closed the PDF forms are connected to the template and answer file.  Changes made to the form 
before being saved are also made in the answer file (Figure 1). Once saved, changes to the form are not 
changed in the answer file (Figure 2).  The file extension .HPD is attached to all saved forms.  These saved 
forms will not be recognized by IowaDocs®, so to reopen these forms you must access them thru the HotDocs 
Filler program. 

 
RTF Documents 

 
Once IowaDocs® displays an assembled RTF document in your default word processor, the document is a 
normal word processing document.  You can manipulate this document just like any other word processing 
document.  You may change your answer or standard document text.  Any changes made will not be saved in 
the answer file.   
 
Once finished with a RTF document it can be: 
Saved    
Printed   
Answer File Saved  

 
Saving a PDF based Form  
 
When you save a form, HotDocs closes the current answer file. (You will be asked if you want to save the 
answers first.) Any changes you make to the answers in the form once the form has been saved will not be 
saved in an answer file. 
 
You will be able to save your documents as and HPD (HotDocs PDF Document) or as a PDF (portable document 
format). 
 
NOTE:  A HPD file is editable, using HotDocs Filler, but the PDF format will not be editable.  A PDF format is 
convenient for sharing with others that do not have HotDocs, such as clients. 
 

1. Go to the File menu, click Save Document As. 
2. Go to the “Save Type as” field and select HPD or PDF  (For security options, see “ HotDocs PDF Advantage’). 
3. Name your file. 
4. Navigate to the directory you would like to save to and click on Save. 

 

*Tip 

A saved PDF based form has the file name extension .HPD.  It also is not connected to the answer file. 

 

Figure 1 Figure 2 
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Printing a Form 
 
Printing a PDF-based form in HotDocs follow these steps. 
 

1. Click on the Form Document Tab located at the top or bottom of the Assembly window. 
2. On the File menu, click Print. (select Acrobat or HotDocs driver if given the option) 
3. Print window will appear, make sure proper printer and options needed are selected. 
4. Click OK. 

 
▪ To print a Question Summary:  Click Question Summary Tab then select Print 

(if you do not see the Question Summary Tab then go to View Menu and check Question Summary Tab – more information 
about this tab on next page) 

▪ To print an Answer Summary:  Click Answer Summary Tab then select Print 
(if you do not see the Answer Summary Tab then go to View Menu and check Answer Summary Tab – more information 
about this tab on next page) 

 
End of Interview Options 
 
The “End of Interview” screen is now customizable.  As a default you only have one option selected for you.  
The option is “View the assembled form document at the Form Document tab…”.  This option will open the 
“Form Document” tab for you.  Below is a list of options you can select to have shown at this screen each time 

you assemble a document.  Click on the  options button to view all the options available. 
 

 

 
 
By default the first 4 options and last are selected.  The 
other 2 most people might want to have select are: “Save 
the assembled document in a file” and “Save the assembled 
document as a PDF”. 
 
Notice that you do not have the option of sending the 
document to Filler.  In order to do this select the “Send 

document to HotDocs Filler” tool in the tool menu ( ) or 
select the F11 key on your keyboard. 
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Tab Options for Assembling Forms 
 
When you are assembling a form, by default, only the Interview and Form Document (or Document Preview) 
are visible tabs.  However there are two others that can be displayed: (These tabs are useful especially if you 
have forms dictated or filled out by a client because they follow the actual interview that a user fills out.) 
 

Question Summary Tab.  This tab allows you to view/print all questions that the interview will ask.  It 
will give the question and a line for an answer.  For those that use dictation of forms, this is an option 
to explore. 

• To view this tab when you assemble a form, open up a form and at the Interview Tab 
go to View and select Question Summary Tab.  This tab will always be visible. 

 
Answer Summary Tab.  This tab is the same as the Question Summary except it will display any 
answers you have filled out already.  If an answer wasn’t given then it will insert a blank line. 

• To view this tab when you assemble a form, open up a form and at the Interview Tab 
go to View and select Question Summary Tab.  This tab will always be visible. 
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HotDocs PDF Options 
 
HotDocs allows you to save templates as PDF’s (Portable Document Format) and share with anyone 
electronically.  You have the ability to save documents as a secure PDF.  Secure PDF’s can have passwords, 
disallow content copy or printing, and other security options are available. 

 
In IowaDocs® during the interview:  (Save As Option) 
 

1. At the “End of Interview” or “Form Document” tab go to File/Save Document As. 
2. Select “Save As Type” option “PDF File (*.pdf)” and give your file a File Name.   
3. To protect the document, select the “Security…” button.  If you do not select the security button then 

your PDF file can be easily copied or changed.  Below is a screenshot of the security options available: 

 

 
 

In HotDocs Filler:  (Save As Option) 
 

1. Go to File/Save Document As. 
2. Select “Save As Type” option “PDF File (*.pdf)” and give your file a File Name.   
3. To protect the document, select the “Security…” button.  If you do not select the security button then 

your PDF file can be easily copied or changed.  Below is a screenshot of the security options available: 
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About Answer Files 
 
When you assemble a document, you can save the information you entered for the document (the "answers") 
in a HotDocs answer file.  The answer file stores each answer along with the name of the variable that uses 
that answer. The answer file can be used again later to produce the same document or form without re-
entering the answers to the interview questions. You can also use the answer file to assemble documents from 
other templates that use the same variables. 
 
The best way to organize your answer files depends largely on your type of practice. Some users create one 
answer file per client. Others create one answer file per matter. (This method is especially good when you 
have multiple matters per client that use the same forms, because it prevents the answers from the current 
matter from overwriting the answers from a different matter and the answers from a previous matter from 
getting used accidentally in the current matter.) Still other users combine the two methods, creating a pattern 
answer file for each client that contains basic client information, and then using the pattern file to copy the 
answers into a new file every time they start a new matter for the client. 
 
Answer files have the filename extension .ANX (or .ANS) and are stored by default in the default answer file 
directory. You can specify a different directory when you create an answer file. 
 

 
NOTE:  All 3 of the above forms are using the same answer file. 
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Using an Existing Answer File 
 
You can use an existing answer file to assemble a template. You can save any changes you make to the 
answers in the file, or you can use the answer file but not save your changes. 
 
To use an existing answer file 
 

1. Open the template you would like to use. 

2. At the Answer File dialog box, click on the Select Answer File button ( ). 
3. Find the Answer File you want to use.  Click on Open 
4. Assemble the template. 

 

*Tip 

To reopen the last answer file you used, click on the drop down menu to select the previous answer files you have used. 
 
You can select an answer file so that it can be used for all documents you assemble and forms you fill until you select another answer 
file.  Check the “Remember Selected Answer File” box. 

 
Save an Answer File During Assembly (Recommended) 
 
You can save an answer file while you are assembling a template. 
 
To save an answer file during assembly 
 

1. Go to the File menu and select Save Answers As… (use Save Answers if you have already saved the 
answers once before) 

2. Give your answer file a file name (i.e. client name) 
3. Hit your tab key – this will take you to the Title field – this will automatically put in your file name for 

you. 
4. Click on OK 

 
If you are using a new answer file, HotDocs opens an empty, untitled answer file. Give the answer file a name. 
If you are using an existing answer file, HotDocs saves the answers you have entered to that file. 

 
About the Answer File Manager 
 
The answer file manager helps you manage your answer files, much like a HotDocs library helps you manage 
your templates and clause libraries. The answer file manager is a list of answer file titles. Each title is 
associated with an answer file filename. When you select an answer file and click Select, HotDocs uses the 
associated file. 
 
Each copy of HotDocs can have only one answer file manager. If you want to separate your answer files, you 
can create folders in the answer file manager window. 
 

*Tip 

Answer File Manager is disabled if you use windows explorer to save answers. 
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Displaying the Answer Library 
 
To display the answer library: 
 

1. At the IowaDocs® library window, click Tools. 
 

2. Select Answer File Manager ( ). 
 

Properties Pane View 

 
 
 

Contents Pane View 
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Finding an Answer File 
 
You can quickly find a certain answer file in the library by searching for words in the answer file's title or 
description. 
 
To find an answer file 
 

▪ Select the Find check box and type words from the answer file's title or notes in the text box. 
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Customizing IowaDocs® 
 
Adding Text to a bordered form  
NOTE: Same process for HotDocs Filler. 

1. Open Form to be filled. 
2. Assemble form. 

3. Go to the Document Tab to view the actual document and make sure the select tool ( ) is selected 
4. Draw field where text is to be inserted. (Simply left click and drag.) Remember text can only be added 

where no text exists.   

5. Now click on the fill tool ( ) and enter the text you need.  

 
Override a Field on a bordered form 
You can ‘override’ any field on a document.  Doing so will not save this information on the answer file so it is 
recommended that the field is not filled in before overriding. 

 
1. Click on the “Form Document” tab. 
2. Navigate to the field to change. 
3. Click inside the field. 
4. Select “Override Field” from the “Fields” menu option. 
5. Click OK. 
6. Type in the text you would like to appear. 

 

To size and position field 
NOTE: Same process for HotDocs Filler. 

1. Select field to be moved or resized. 
2. Once selected right click on mouse. (Menu option will appear) 
3. Select resize/move 
4. Handles or small boxes will appear on field. (These handles are used to move and resize.) 
5. The handle in upper left corner of the field is used to move a field. 
6. Selecting any other handle will resize the field. 

 

Striking Out Text 
NOTE: Same process for HotDocs Filler. 

1. Open Form to be filled. 
2. Assemble form. 

3. Go to the Document Tab to view the actual document and make sure the Select Tool ( ) is 
selected  

4. Position field over text to be stricken (create the field a little larger than needed). 
5. Go to the Field menu and select Properties. 
6. In the Properties window check “Strike-Through”(lower right corner). 

7.  Select the fill tool ( ), click inside the field type an “X” or a “-“. 
8. Click outside the field.  Your field will be inputted with the above type. 

NOTE:  If you use HotDocs Filler then the tool  is called “Select Fields” and not “Select Tool”. 

 
*Tip 

To get multiple lines to be stricken – give a hard return (type the Enter Key) for one less then the number of lines you need (i.e. If you 
need 4 lines to be stricken you need 3 hard returns,  do this:  type an x, hit enter key, type x, hit enter key, x, hit enter key, type x) 
Properties, such as bold, italic, etc. can be changed under the Field/Properties. 
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Enlarging and Reducing the Form View 
 
By default, forms in HotDocs Automator display at their actual size. 
 
To enlarge or reduce the form view 
 

View Page Width  or view full page  
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Change Your Default Word Processor 
 
If you have more than one word processor installed, you can select a default word processor to which you 
send an assembled document after you complete a HotDocs interview. This word processor will always be 
used, no matter which format the template is in when you select it for assembly. (For example, if you select a 
Word template but want the assembled document to be saved as a WordPerfect file, you can select 
WordPerfect as the default word processor and HotDocs will convert the assembled Word document to 

WordPerfect format.) Note, however, that if you save a document to disk (by clicking the  Save Document 
button) without sending it to the word processor first, it will be saved in the same format as the original 
template file.  
 
To specify a default word processor 

1. At the HotDocs library, click the Tools menu then click on the Options button. The HotDocs Options 
dialog box appears. 

2. Click the Word Processors folder. The right pane changes to show a drop-down list of available word 
processors. 

3. Click the Default Word Processor drop-down button and select a word processor. 
 

Showing or Hiding Field Backgrounds 
 
You can show or hide the field backgrounds in forms. By default, field backgrounds are visible.  
 
To show or hide field backgrounds 
 
Select the Form Document tab, go to View and select Show Answer Fields.  Select again to turn back on 
 
On the View menu in Filler, click Fields. 
 

*Tip 

You can also show or hide fields by clicking the View Fields button  on the toolbar. 

 

To open a saved PDF-based (HPD) form  
 

1. Start HotDocs Filler if it is not already open.  
2. On the File menu, click Open. 
3. Select the file you want to open and click OK or Open. 

 
If the form was saved as a PDF you can open this form using Adobe Acrobat Reader.  Please refer to page 11 
“Saving a Form” for more information on the difference of a HPD and PDF file. 
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Keyboard Shortcuts 
 
Open   Ctrl+O 
Close   Ctrl+F4 
Save   Ctrl+S 
Exit   Alt+F4 
Undo   Ctrl+Z 
Redo   Ctrl+Y 
Cut   Ctrl+X or Shift+Delete 
Copy   Ctrl+C or Ctrl+Insert 
Paste   Ctrl+V or Shift + Insert 
Delete   Del 
Select All  Ctrl+A 
Previous Page  Alt+PgUp 
Next Page  Alt+PgDn 
Go To Page  Ctrl+G 
Fit Page to Width Ctrl+H 
Zoom In  F10 
Zoom Out  F9 

 
Keystrokes for Symbols (most common) 
 
Description Character ASCII 
Degree sign ° ALT 0176 
Section sign § ALT 0167 
round filled bullet • ALT 0149 
copyright sign © ALT 0169 
registered trademark sign ® ALT 0174 
trademark sign ™ ALT 0153 
one half sign ½ ALT 171 
one quarter sign ¼ ALT 172 
three quarter sign ¾ ALT 0190 
cent sign ¢ ALT 0162 
en dash – ALT 0150 
em dash — ALT 0151 
per thousand (mille) sign ‰ ALT 0137 

 


